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1. Introduction

The devices of GD32VW553 series MCU are 32-bit general-purpose microcontrollers based
on the Nuclei N307 processor. The N307 processor is based on the RISC-V architecture
instruction set.

This application note is designed to help users to build and develop GD32VW553 series MCU
project in SEGGER Embedded studio for RISC-V (SES) IDE.
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2. Development environment

Evaluation board: GD32VW553H-EVAL-V1.1
Hardware debugger: J-Link V11 / V12

IDE: SEGGER Embedded Studio for RISC-V V7.32a
Operating system: WIN10 64-bit OS
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3.

3.1.

Project development

Device support package installation

The device support package can be installed online or offline in SES (the offline package is
available from https://gd32mcu.com), which refers to Fiqure 3-1. Device support package

installation options. Open SES software, online package can be installed by "Package
Manager...", which refers to Figure 3-2. Device support package installation online;

offline package can be installed by "Manually Install Packages...", which refers to Fiqure 3-3.

Device support package installation offline..

Figure 3-1. Device support package installation options

© Hello - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commerdial License - o x
Fle Egt Viw Sech Navigste Project Buld Debug Target | Tool
Bl x |[ raine & o A - I
<3 Debug oo ® o @
Code | Dats-RO -
Cs
W
5 MNew Ctrek, F
Browser 3 H
Studio
Terminal Emulator 0
SEGGER Embedded Studio for " "gE; Projects | B3 openexsting || [ Create new
RISC-V is up to date
Today
O Helo
All packages are up to date Chosk for Padoges
Qutput G x
Tasks  ~
() Disconnected (Simulator) ) Buitt OK | INS (Mo editor)
Figure 3-2. Device support package installation online
%* SEGGER Embedded Studio for RISC-V V7.32a - Package Manager 7 X
Select Packages
GDI2VWSS5x o o O
Title . Version Type Status Action
GigaDevice
GD32VW55x CPU Support Package 1.00 ~ | CPU Support Mo Action
~
Package Information
Description This package contains project templates and system files for the GigaDevice GD32VW55x.
Installed Version 1.00
Author SEGGER Microcontroller GmbH ©
Back Cancel
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3.2.

Figure 3-3. Device support package installation offline

© Install Target Suppart Packages X
1 » ol - Dwes U T R GD32vW55x_Addan v B
0O =# ESid) Foh
| = GD32VW55x - 1.00.emPackage 11/9 15:01 SEGGER Embed... 443 KB
JHEMN): | GD32VWS5x - 1.00.emPackage v| Support Package Files (.em

Create project based on the template

The steps to create a new project based on the template are as follows:

Step 1: Open SES software and clicking "File->New Project" option and then choose "A C/C++
executable for GigaDevice GD32VW55x" and set the project name and location to create
project, which refers to Fiqure 3-4.Create a project based on the template.

Figure 3-4.Create a project based on the template

> SEGGER Embedded Studio for RISC-V V7.32a - New Project X

Select new project template )

i) Don't see your device or board? Use the Package Manager to install packages

Description Manufacturer | Beard
GigaDevice

[AC/C++ executable for GigaDevice GD32vWSSx. | GigaDevice
An assembly code only executable for GigaDevice GD32VW35x, GigaDevice
An externally built executable for GigaDevice GD32VW355x. GigaDevice
Alibrary for GigaDevice GD32VW35x GigaDevice

Name: Project

Location: | DAGD32VW353 Browse

Back Cancel

Step 2: Click "Next" to enter the common project setting interface, including chip selection,

compiler type selection, link output format selection, predefined macro setting, header file
8
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containing path setting, input/output support and stack size configuration, which refers to
Figure 3-5.Common project settings based on the template.

Figure 3-5.Common project settings based on the template

©* SEGGER Embedded Studio for RISC-V V7.32a - New Project X

@ Choose common project settings

Properties:

Option Value
Build
= Target Processor GD32VW353HMQ7
Compiler
= Compiler SEGGER
Debugger
* |5A Extensions Debug None
Linker
= Additional Output Format None
Preprocessor

= Preprocessor Definitions
s UserInclude Directories

Printf/Scanf

= Printf Floating Point Supperted  No

= Printf Integer Support int

= Printf Width/Precision Supported No

» Scanf Classes Supported No

# Scanf Floating Point Supperted  No

= Scanf Integer Support int
Runtime Memory Area

» Stack Size 2,048 bytes

Target Processor

Select a set of target options

Back Cancel

Step 3: Click "Next" to enter the project files selection interface and the default selection
should be used, which refers to Figure 3-6.Project files selection based on the template.

Figure 3-6.Project files selection based on the template

©* SEGGER Embedded Studio for RISC-V V7.32a - New Project X

@ Select files to add to project

Files:
(L) Device Files
& Script Files
(23 Source Files
(23 System Files

Import all files and package files

Back Cancel
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Step 4: Click "Next" to enter the project configurations interface, which refers to Figure
3-7.Project configurations based on the template.

Figure 3-7.Project configurations based on the template

©* SEGGER Embedded Studio for RISC-V V7.32a - New Project X

@ Select configurations to add to project

Configurations:
Debug
Release

Back Finish

Step 5: Click "Finish" to enter the project interface, users can carry out secondary
development based on this template project, which refers to Figure 3-8. New project based
on the template.

10
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3.3.

Figure 3-8. New project based on the template

© Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Nen-Commerdial License
File Edit View Seach Navigate Project Buld Debug Target Tools Window Help

0 x || CEED
2 Debug M= S -« A

Project ftems Code | DatasRO
Solution Project
4 [ Project Project’
(2 Device Files  32files
(] Script Files 1 file
(22 Source Files 1 ile, modifi
(22 System Files 2 files

=

SEGGER

Studio

SEGGER Embedded Studio for RISC-V is up to date

Check for Updates

All packages are up to date

Check for Packages

Projects

Show: | Transcript v Y % [Tk -

() Disconnected (-Link) & Built OK NS

> Open existing H [ create new

(No editor)

Create project based on the standard firmware library

The steps to create a new project based on the standard firmware library are as follows:

Step 1: Open SES software and clicking "File->New Project" option and then choose "A C/C++
executable for GigaDevice GD32VW55x" and set the project name and location to create
project, which refers to Figure 3-9. Create a new project based on the standard

firmware library.

Figure 3-9. Create a new project based on the standard firmware library

©» SEGGER Embedded Studio for RISC-V V7.32a - New Project

Select new project template

i) Don't see your device or board? Use the Package Manager to install packages

Description

&

GigaDevice

| AC/C++ executable for GigaDevice GD32VW55x. |
An assembly code only executable for GigaDevice GD32VW55x.
An externally built executable for GigaDevice GD32VW35x,
Alibrary for GigaDevice GD32VW355x,

Mame: Project

Location: | DAGD32VWS5x_Firmware_Library!\ Template\SES_project

GD32VW355x L]

Manufacturer

GigaDevice
GigaDevice
GigaDevice
GigaDevice

Back

Board

Generic GD32VW35x

Generic GD3
Generic GD3
Generic GD3
Browse
Cancel

Step 2: Click "Next" to enter the common project setting interface, including chip selection,

11
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GigaDevice

compiler type selection, link output format selection, predefined macro setting, header file
containing path setting, input/output support and stack size configuration, which refers to
Figure 3-10. Common project settings based on the standard firmware library.

Figure 3-10. Common project settings based on the standard firmware library

% SEGGER Embedded Studio for RISC-V V7.32a - New Project

@ Choose common project settings

Properties:

Option Value
Build
= Target Processor GD32VW5353HMQ7
Compiler
= Compiler SEGGER
Debugger
= |SA Extensions Debug Mone
Linker
* Additional Output Format Mone
Preprocessor

» Preprocessor Definitions
# User Include Directories

Printf/Scanf

= Printf Floating Point Supported Mo

# Printf Integer Support int

* Printf Width/Precision Supported Mo

» Scanf Classes Supported Mo

= Scanf Floating Point Supported Mo

» Scanf Integer Support int
Runtime Memory Area

= Stack Size 2,048 bytes

Target Processor

Select a set of target options

Back

Cancel

X

Step 3: Click "Next" to enter the project files selection interface, uncheck all the default
configuration items, which refers to Figure 3-11. Project files selection based on the

standard firmware library.

12
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Figure 3-11. Project files selection based on the standard firmware library

%> SEGGER Embedded Studio for RISC-V V7.32a - New Project X

@ Select files to add to project

Files:

O
- O (22 Script Files

- [ (3 Source Files

- [ (23 System Files

Import all files and package files

Back Cancel

Step 4: Click "Next" to enter the project configuration interface, which refers to Figure 3-12.
Project confiqurations based on the standard firmware library.

Figure 3-12. Project configurations based on the standard firmware library

L#3

@ Select configurations to add to project

Configurations:

[ Debug
Release

Back Finish Cancel

Step 5: Click "Finish" to enter the project interface, users can carry out secondary
development based on this empty project, which refers to Fiqure 3-13. Empty project.

13
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Figure 3-13. Empty project

foog o @
Data+RO

£t Release

Project ltems Code
Solution project’
[ Project project’

SEGGER

© project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License - o X

File Edit View Search Navigate Project Build Debug Target Tools Window Help

Project Explorer e I R Dashboard B & x
~

D>

-

Studio

SEGGER Embedded Studio for RISC-V is up to date

Check for Updates

All packages are up to date

Projects

Show: | Transcript T Y Y [Tk -

project emProject saved

Check for Packages

> Open existing H [ create new .

() Disconnected (-Link) @ Built OK  INS (No editor)

Step 6: Organize the firmware library files according to the following structure, which refers to
Figure 3-14. Project files . The specific file structure can refer to firmware library template

project.

Figure 3-14. Project files structure

© Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License
file Edit  View Search Mavigate Project Bulld Debug Targst Tools Window Help

Project Explorer | x

7% Release o a o o
Data+RO

main.c  gd32vws53h evalc  gd3vwsSx gpio.c

Project ltems Code
Solution Project’
4[] Project Project”
4 3 Application 3 files
& gd32vwSSiit.c
£ mainc
£ systick.c
4 S Doc il
) readmesat
4 (23 Peripheral 28 files
(32 Source  287iles

SEGGER

-

Studio

&) system_gd32vwS5x.c
4 CYRISCY  20files
(0 drivers  14files

SEGGER Embedded Studio for RISC-V is up to date

Check for Updates

(03 env_SES  Giles
4 23 ScriptFiles 1 file
GDI2VWS55_Targetjs
a (3 Utilities  1ile

£ 9d32vw553h_evale All packages are up to date

Projects

Show: | Transcript % % [Tasks -

Check for Packages

| > Open existing H [ Create new o)

() Disconnected (GDB Server) @ Built OK  INS (No editr)

Step 7: Click "Project->Options" to enter project options interface and configure header file
containing path, which refers to Figure 3-15. User include directory confiqurations.

14
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Figure 3-15. User include directory configurations

Project ‘Project ' Options

T L | %rRelease

a Code
Assembler
Build
Code Anslyzer
Code Generation
Compiler
Compiler W:
Extemal Build
File
Library
Linker
Preprocessor
Print/Scanf
Runtime Memary Area
Section
Source Code
User Build Step

4 Debug

ning

Debugger
GDE Server
JeLink
Loader
Simulatar
Target Script

©| [ Show Modified Gptions Only

Optien Value -
. et @ SEGGER Embedded Studic for RISC-V V7.32a - Property Editor x
s Analyze Command Mone
. - Set User Include Directories
- Assemble Command Hiane
s € Compile Command Mane Project Project
* Ce+ Compile Command Mane Configuration: Release
4 W Library User Include Directories:
+ Library VO Hone  modfied |
4 W Preprocessor
S— _— - 325 5 standrd,_perighenal
[ R\ Utilties; 3\ \\ Firrraware'\ GD32V W35 standard peripherak -] AW standend e

+ User Includle Directories Assembler Only
»_User Include Directories € Compiler Oniv

User Include Directories

Specifies the user include path, This property will have macro expansion applied to it

] AAFirmware RISCV, drivers

Macros: v

Cancel

Cancel

Specifies the user include path. This property will have macro expanzion applied to it

Step 8: Click "Project->Options" to enter project options interface and configure the script file,
which refers to Figure 3-16. Scripts configurations.

=3

T

4 Code
Assembler
Build
Code Analyzer
Code Generation

% Release

Compiler
Compiler Warning
External Build
File
Library
Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step

4 Debug
Debugger
GDB Server
J-Link
Loader
Simulator

Target Script

Figure 3-16. Scripts configurations

[ show Modified Options Only

Option Value
4 B Target Script

* Debug Begin Script None

* Debug End Script None

* Load Begin Script None

* Load End Seript Nene

o Reset Seript Resetl  modified

*_ Target Script File A V\env SES\GD32VWS5 Targetjs =

Target Script File

The target script file, the contents of this file are prepended to script project properties before they are executed,

Cancel |

> SEGGER Embedded Studio for RISC-V V7.32a - Property Editor x

Set Target Script File

Project: Project
Configuration: Release
Terget Script File:

Browse

Macros: ~)

Cancel

The target seript file, the contents of this file are prepended to script project properties
before they are executed

-
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4.

4.1.

IDE interface introduction

Project configuration options

Users can right-click the Solution / Project / folder / file under the "Project Items" column and
select "Options..." to set the configuration options, which refers to Figure 4-1. Project

confiquration options.

Figure 4-1. Project configuration options

s
Fie Edt View Semch MNmigste Project Buld Debug Tager Tooks Wndow Help
o x @B )
oo owe v Q€ k]
Code | DatarRO ) " =
@ SEGGER Embedded Studio for RISC-V V7.32a - Options. x
Project 'Project ' Options
] Show Modified Opticns Gnly
g
=
ves
o x
o 1 cance
Shave, &
) Disconnected (GDB Server) | & Built OK IS (e ecitar)

16
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4.1.1.

4.1.2.

Chip selection

Figure 4-2.Chip selection

%* SEGGER Embedded Studio for RISC-V V7.32a - Options

Project ‘Project ' Options

T | | £3Release -

4 Code Option
Assembler
Build 4 W Build
Code Analyzer
Code Generation
Compiler 2 B External Build
Compiler Warning » Assemble Command
External Build » C Compile Command
File # C++ Compile Command

= Target Processor

Library

Linker

Preprocessor
Printf/Scanf

Runtime Memory Area
Section

Source Code

User Build Step

[] Show Medified Optiens Only

Value

GD32VW353HMOT (inherits )

None
Naone
None

a Debug Target Processor =
Debugger Select a set of target options
GDE Server
J-Link ® property rv_architecture=rv32gc
Loader ® property rv_abi=ilp32d
Simulat ® property target_device_name=GD32VW333HMOT7
imulatar * property debug_register_definition_file=$(PackagesDir)/GD32VW3 5%/ XML/GD32VW553x_Registers.xml
Target Script ® property linker_memory_map_file=S{PackagesDir)/GD32VWS55x/XML/GDI2ZVW553HMOT_MemaryMapxml v
® nranarty
Cancel
Assembler / compiler selection
Figure 4-3. Assembler selection
%* SEGGER Embedded Studio for RISC-V V7.32a - Options X

Project 'Project ' Options

T L £ Release - [ Show Modified Options Only
4 Code Optien Value

Assembler

Build 4 B Assembler

Code Analyzer = Assembler gcc =]

Code Generation
Compiler = Additicnal Assembler Options From File SEGGER

* Additionsl Assembler Options “

Compiler Warning SEGGER Assemnbler
External Build

File

Library

Linker

Preprocessor

Printf/Scanf

Runtime Memory Area

Section
Source Code
User Build Step

4 Debug Assembler
Debugger
GDB Server
J-Link
Loader

Specifies which assembler to use, SEGGER Assembler Technology preview - For test purposes only.

Simulator
Target Script

Cancel
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4.1.3.

Figure 4-4. Compiler selection

%* SEGGER Embedded Studio for RISC-V V7.32a - Options

Project ‘Project ' Options

Code Generation
Compiler
Compiler Warning
External Build

File

Library

Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section

Source Code

User Build Step

a4 Code Option
Assembler
Build a W Compiler
Code Analyzer = Compiler

Use Compiler Driver

Keep Assembly Source
Keep Preprocessor Qutput
Supply Absolute File Path

Additional C/C++ Compiler Options

Additional C Cempiler Only Options

4 Debug Compiler
Debugger Specifies which compiler to use.
GDE Server
J-Link Inherits
Loader "SEGGER" from project in Commen configuration
Simulator
Target Script

Enable All Warnings C Cempiler Only Command Line Options
Enable All Warnings C++ Compiler Only Command Line Options
Enable All Warnings Command Line Options

Enforce ANSI Checking C Command Line Opticns

Enforce ANSI Checking C++ Command Line Options

Enferce ANSI Checking Cemmand Line Options

Additional C/C++ Cempiler Options From File

Additinnal C Comniler Only Ontinns From File

[] Show Modified Options Only

Value =

SEGGER  inherits =

None

Nnne

Link script and link output format configuration

Figure 4-5. Link script and link output format configuration

1. Release

Code Generation

Compiler * Memory Map File S$(PackagesDir)/GD32VW55/ XML/GD32VW553HMQ7_Memory|
Compiler Warning ¢ Memory Map Macros
External Build + Memory Segments None
+ Supply Memory Segments To Linker [segger-Id] Ves

File
b + Generate Log File [segger-Id] No

ora o Generate Map File [segger-ld] Standard

L *_Map File Format [seqger-Id] Text
Preprocessar » Additional Qutput Fermat Mone - |
Printf/Scanf ¢ Link Dependent Projects Yes

Runtime Memory Area
Section

Source Code

User Build Step

a Code Option
Assembler
Build 4 B Linker
Code Analyzer o Linker

[ Show Medified Qptions Only

Value ®

SEGGER _inherits

[+ Linker Script File

S(PackagesDir)/GD32VWS55x/Scripts/GD32VW55x_Flash.icf _ink|

¢ Additional Input Files
¢ Linker Symbol Definitions
¢ Entry Point

¢ Keen Sumbnls

The format used when creating an additional linked output file. The options are:

a Debug Additional Output Format
Debugger
GDB Server
J-Link * None do not create an additional output file.
Loader *bin create a binary file.
Simulat * srec create a Motorola 5-Record file,
imula or. * hex create an Intel Hex file.
Target Script

Reset_Handler inherits

18



e AN186
GigaDevice Development Guide for GD32VW553 series MCU in SEGGER Embedded Studio IDE

4.1.4. Input / output library configuration

Figure 4-6. I/O library configuration

%* SEGGER Embedded Studio for RISC-V V7.32a - Options X

Project 'Project ' Options

T L[5 Release = @[] Show Modified Options Only

a4 Code Option Value
Assembler
Build 4 W Library
Code Analyzer o Library I/0 None modified E

Code Generation RTT

Compiler SEMIHOST

Compiler Warning SEMIHOST (host-formatted)

Exdermal Build

File

Library

Linker

Preprocessor
Printf/Scanf

Runtime Memory Area
Section

Source Code

User Build Step

4 Debug Library /0 [l
Debugger Specifies how the library does I/O.
GDE Server Options are:
J-Link
Loader ® RTT: Use SEGGER Real-Time Transfer for 170 operations without halting the system. Recommended for maximum speed.
Simulator * SEMIHOST: Format output and write to RAM buffer. Halt CPU for [/0 operation. Provides hosted file [/0.
* SEMIHOST (host-formatted): Halt CPU for /0 operation. Recommended for minimum size.
Target Script * None: Do net include /0 implementation, Use user-supplied 1/0 Mechanism.,

Cance

When the "None" is selected, user can specify the print serial port by modifying the macro
USART_PRINT in the "SEGGER_RTL_PRINOPS_UART_Unbuffered.c " file, which refers to
Figure 4-7. Hardware USART configuration.

Figure 4-7. Hardware USART configuration

SEGGER_RTL_PRINOPS_UART_Unbuffered.c

®
B e e S L]

=/

#include "_ SEGGER_RTL_Int.h"
#include "gd32wws5x.h"
#include "stdio.h”

24  |pdefine USART PRINT |USART@

19
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4.1.5. Input / output format support configuration

Figure 4-8. Input/output format support configuration

% SEGGER Embedded Studio for RISC-V V7.32a - Options

Project 'Project ' Options

T | | %2 Release = || Search Options [] Show Madified Options Only
4 Code Option Value
Assembler
Build 4 B Printf/Scanf
Code Analyzer = Printf Floating Point Supported Float = modified =
Code Generation s Printf Integer Support int
Compiler * Printf Width/Precision Supported Yes modified
Compiler Warning » Scanf Classes Supported No
External Build » S5canf Floating Point Supported No
File » Scanf Integer Support int
» Wide Characters Supported Yes  modified
Library
Linker
Preprocessor
Runtime Memory Area
Section
Source Code
User Build Step
a Debug Printf Floating Point Supported
Debugger Are floating point numbers supported by the printf function group.
GDE Server
J-Link
Loader
Simulator
Target Script
Cancel
4.1.6. Preprocess configuration
Figure 4-9. Preprocess configuration
% SEGGER Embedded Studio for RISC-V V7.32a - Options X

Project 'Project ' Options

T |4 Release ¥ | |Search Options [] Show Modified Options Only
4 Code Option Value @
Assembler @ TTEPIoCEsSor
Build * Ignore Includes No
Code Analyzer ¢ Include Files

¢ Include Files Assembler Only
#* Include Files C Compiler Only

Code Generation

Compiler s Include Files C++ Compiler Only
Compiler Waming ¢ _Preprocessor Definitions inherits |
External Build ¢ Preprocessor Definitions Assembler Only
File ¢ Preprocessor Definitions C Compiler Only
Library * Preprocessor Definitions C++ Compiler Only
Linker * Preprocessor Undefinitions
* Preprocessor Undefinitions Assembler Only
Printf/Scanf ¢ Preprocessor Un\:lef!mtmnsc Cumpller.On\y
Runtime Memory Area * Preprocessor Und.eflmt\?ns C++ Compiler Only
. * System Include Directories
Section ¢ _Undefine All Preprocessor Definitions No
Source Code |- User Include Directories ‘,"‘\\;..\\..\\Utllltle;;..\\..\\Flrmware\\GDSZVWSSx_standard_p"'lv
User Build Step
4 Debug User Include Directories
Debugger Specifies the user include path. This property will have macro expansion applied to it.
GDB Server
J-Link
Loader
Simulator
Target Script

Concel
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4.1.7.

4.1.8.

Optimize level configuration

Figure 4-10. Optimize level configuration

% SEGGER Embedded Studio for RISC-V V7.32a - Options

Project 'Project ' Options

T L | 9iRelease

a Code
Assembler
Build
Code Analyzer
Code Generation
Compiler
Compiler Waming
External Build
File
Library
Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step
4 Debug
Debugger
GDE Server
J-Link
Loader
Simulator
Target Script

Option

4 W Code Generation

« Disable Function Inlining
Link Time Optimization

Machine Qutliner [segger-cc]
Optimization Level

4 W Library
« Library Optimization

4 W Linker

« Enable Outline Optimization [segger-Id]

Optimization Level

Specifies the optimization level to use. The options are:

® None - don't specify an optimization level

Keep Link Time Optimization Intermediate Files

Link Time Optimization Additional Options

Value

No
Mo
No

Mone

@[] Show Modified Options Only

Mone  modified i

Level 0
Level 1

Level 2 for speed
Level 2 balanced

Level 2 for si

Level 3 for more speed

ize

# Level 0 - no optimization, fastest compilation and best debug experience.

® Level 1 - optimize minimally.
*® Level 2 for speed

® Level 2 balanced

® Level 2 for size

® Level 3 for more speed - optimize even more, will take longer to compile and may produce much larger code,

Cancel
Stack configuration
Figure 4-11. Stack configuration
©* SEGGER Embedded Studio for RISC-V V7.32a - Options X

Project 'Project ' Options

T L |3 Release

a Code
Assembler
Build
Code Analyzer
Code Generation
Compiler
Compiler Warning
External Build
File
Library
Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step
4 Debug
Debugger
GDB Server
J-Link
Loader
Simulater
Target Script

Option

4 B Code Generation
* Stack Sizes

4 H Debugger
» Starting Stack Pointer Value

4 W Linker

* Suppress Waming on Executable Stack

4 W Runtime Memory Area
» Stack Size

Walue

No

_stack_end__

Mo

2,048 bytes

inherits

inherits

©/ [] Show Modified Options Only

Cancel
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4.1.9. Debugger configuration

Users can choose J-Link or GDB Server to download and debug the project, which refers to
Figure 4-12. Debugger configuration.

Figure 4-12. Debugger configuration

%> SEGGER Embedded Studio for RISC-V V7.32a - Options *

Project 'Project ' Options

T L |7 Release - Options [] show Modified Options Only
4 Code Option Value &
Assembler
Build 4 W Debugger
Code Analyzer = Target Connection | J-Link_ modified IE‘
Code Generation ¢ Run To Control Simulator
Compier  RunTo
Compiler Warning * Startup Completion Point GDE Server
External Build * Start From Entry Point Symbol VEE T TRRERTE
Fie * Leave Target Running No
Library  CPU Register File S(StudioDir)/targets/cpu_registers_riscvxml )
* Register Definition File $(PackagesDir)/GD32VW35x/XML/GD32VW553x_Registers.xml
Linker + Debug Terminal Leg File None
Preprocessor * Threads Script File None
Printf/Scanf & Thread Maximum 25
Runtime Memory Area * Working Directory S(ProjectDir)
Section + Command Arauments S(ProiectName)S(EXE) w
Source Code Target Connection
User Build Step " X X
4 Debug Specifies the target to connect to for debugging actions.
GDB Server
J-Link
Loader
Simulator
Target Script

When choosing J-Link mode for project development, J-Link settings refers to Figure 4-13.
J-link configuration.

Figure 4-13. J-link configuration

%» SEGGER Embedded Studio for RISC-V V7.32a - Options x

Project 'Project ' Options

T L | 9% Release ~ | |Search Options [ Show Modified Options Only
4 Code Option Value &

Assembler

Build 4 B Jlink

Code Analyzer » Host Connection UsB

Code Generation E_Target Interface Type JTAG (inherits -]

Compiler » JTAG Instruction Register Size Before Target Auto Detect

Compiler Warning  JTAG Number Of Devices Before Target Auto Detect

External Build » Enable Adaptive Clocking No

. * Speed 4,000 kHz
File
Lib * Supply Power No
torary  Show Log Messages In Qutput Window Yes

Linker = LegFile None

Preprocessor * Script File Mone

Printf/Scanf s Exclude Flash Cache Range MNone

Runtime Memory Area » Additional J-Link Options

Section s Taraet Has Cvele Counter Ne b

Source Code Target Interface Type

User Build Step
4+ Debug Specifies the type of interface the target has, The options are:

Debugger JTAG - Use JTAG interface

GDB Server ® SWD - Use SWD interface

* cJTAG - Use dJTAG interface

Loader Inherits

Simulator

Torget Script “JTAG" fram praject in Comman configuration

e

When choosing the GDB Sever method for project development, select the appropriate GDB
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4.2.

Server according to the requirements, which refers to Fiqure 4-14. GDB server

configuration.

Figure 4-14. GDB server configuration

%> SEGGER Embedded Studio for RISC-V V7.32a - Options

Project ‘Project ' Options

T L | %%Relesse ~ | | Search Gptions [] Show Modified Options Only
4 Code Option Value Lo
Assembler
Build 4 B GDBServer
Code Analyzer * Host localhost
Code Generation = Type J-Link {medified -
Compiler - il " jce " |
Compiler Warning » Auto Start GDB Server Yes  modified
External Build = Port 2,331 modified
File » Reset and Stop Command modified
Library » Ignore Checksum Errors ) modified
) ® Allow Memory Access During Execution modified
Linker » Register Access modified
Preprocessor » Breakpoint Types Hardware and Software
Printf/Scanf = LogFile None
Runtime Memory Area = Target XML File None
Section » Connect Timeout 3 seconds Y
Source Code Type
User Build Step
4 Debug Specifies the type of GDB server being connected to.IJ'Link, OpenOCD, 5T-LINK and pyQCD gdb saNerIimpIemantatmns are currently
Debugger supported.
J-Link
Loader
Simulator
Target Script
Cancel

Project build options

By clicking "Build" option in the menu bar, user can clear, compile and recompile the Project

/ Solution; In addition, the current active project can be run or debug after compilation, which

refers to Fiqure 4-15. Project build options.

Figure 4-15. Project build options

©* Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License
File  Edit  View  Search  Mavigate  Project Debug  Target  Tools  Window  Help
%0, - -
Project Explorer eiiEuid Bt L
. Rebuild Project Alt+F7
™ =51
1od Release @ a o Clean Project
Project ltems CV Build Soluti Shitt+E7
Solution ‘Project’ @ Build Soluticn i
4 [7] Project ‘Project ’ Rebuild Solution Alt+Shift+F7
> [0 Application 3 files Clean Solution
> [0 Doc  1file o )
> [ Peripheral 29 files % Compile Ctrl+F7
> 8 RISCV @llinies ¥z Build and Debug Ctrl+T, F5
> [ Script Files 1 file ' . R
. [ Utilities 1 file 1.5 Build and Run Ctrl+T, Ctrl+F5
b OutputFiles ?& Cancel Build Ctrl+.
#23  Build Configurations...
Set Active Build Configuration 2
Batch Build 3
Parallel and Unity Build 3
Show Build Log Ctrl+B, Ctrl+T
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4.3.

Project Debug options

By clicking the "Debug" option in the menu bar, the target chip can be debugged, breakpoint
set and other operations, which refers to Figure 4-16. Project debug options and Figure

4-17. Project debugq interface.

Figure 4-16. Project debug options

©* Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License
File  Edit  View  Search  Mavigate  Project  Build Target  Teols  Window  Help
Project Explorer = =
Break Ctrl+.
o« o 5] +
foi Release O @& S <« g Stop Shift+ F5
Project ltems Code 4+ Restart Ctrl+Shift+F5
Selution ‘Project’
P 175 4 Toggle Breakpoint F9
a4 [] Project Project 2.5K
+ [ Application 3 files Breakpoints 4
> (23 Doc  1file .
+ [ Peripheral 29 files E Stepinto F11
> (Z3 RISCV 20 files [Z Step Over F10
» [0 Seript Files  1file 5= Step Out Shift+F11
> 3 Urilities _1 file +=  Run To Cursor Ctrl+F10
+ 21 Output Files _
5= Auto Step
Instruction Step Into Alt+F11
2 Show Mext Statement Alt+*
g_E Set Mext Statement Shift+F10
Switch Debug Mode Ctrl+F11
oo Cuick Watch Shift+F3
&, Debug With Ozone Alt+F5
Options 2
- a x
s g s o «|e> - BICTETE
. e T3 a ] Do
st LA - | §j=
mt | mof
=
Ay
B vt R T :
B o gl
alkE
S G ol Ba
anl;:“omm " o dton)
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4.4.

Target operation options

By clicking the "Target" option in the menu bar, the operations such as connect, disconnect,
attach, download and verify can be performed on the target chip, which refers to Figure 4-18.

Target operation options.

Figure 4-18. Target operation options

File

a [

Edit  View  Search

Project Explorer

. Release

Project ltems
Solution ‘Project’

Project ‘Project’
[Z1 Application 3 files

. [C3 Doc  1file

- ([0 Peripheral 29 files
. [CA RISCY 20 files

- [ Script Files 1 file
- [C Utilities 1 file

+ k=) Output Files

-

il m C:I il {/6{/){9‘}

©» Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License

Debug Tools  Window  Help

Connect J-Link
Disconnect
Reconnect

Attach Debugger

Reset

Download GD32VW55x
Werify GD32VW35x
Erase All

Upload Range...

Download File

Verify File

Start Cycle Counter

Pause Cycle Counter

Zero Cycle Counter

Switch Project

Target Connection Properties

Ctrl+T, C
Ctrl+T, D
Ctrl+T, E
Ctrl+T, H

Ctrl+T, 5
Ctrl+T, L
Ctrl+T, V

Ctrl+T, K

Ctrl+T, Z
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5.

Revision history

Table 5-1. Revision history

Revision No.

Description

Date

1.0

Initial Release

Jan.15 2024
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This document, including any
product of the Company described in this document (the “Product”), is owned by the Company under the intellectual property laws and
treaties of the People’s Republic of China and other jurisdictions worldwide. The Company reserves all rights under such laws and
treaties and does not grant any license under its patents, copyrights, trademarks, or other intellectual property rights. The names and

brands of third party referred thereto (if any) are the property of their respective owner and referred to for identification purposes only.

The Company makes no warranty of any kind, express or implied, with regard to this document or any Product, including, but not
limited to, the implied warranties of merchantability and fitness for a particular purpose. The Company does not assume any liability
arising out of the application or use of any Product described in this document. Any information provided in this document is provided
only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality
and safety of any application made of this information and any resulting product. Except for customized products which has been
expressly identified in the applicable agreement, the Products are designed, developed, and/or manufactured for ordinary business,
industrial, personal, and/or household applications only. The Products are not designed, intended, or authorized for use as components
in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, atomic energy control
instruments, combustion control instruments, airplane or spaceship instruments, transportation instruments, traffic signal instruments,
life-support devices or systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution
control or hazardous substances management, or other uses where the failure of the device or Product could cause personal injury,
death, property or environmental damage ("Unintended Uses"). Customers shall take any and all actions to ensure using and selling
the Products in accordance with the applicable laws and regulations. The Company is not liable, in whole or in part, and customers
shall and hereby do release the Company as well as it’s suppliers and/or distributors from any claim, damage, or other liability arising
from or related to all Unintended Uses of the Products. Customers shall indemnify and hold the Company as well as it's suppliers
and/or distributors harmless from and against all claims, costs, damages, and other liabilities, including claims for personal injury or

death, arising from or related to any Unintended Uses of the Products.

Information in this document is provided solely in connection with the Products. The Company reserves the right to make changes,

corrections, modifications or improvements to this document and Products and services described herein at any time, without notice.

© 2024 GigaDevice — All rights reserved
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